
USER 
MANUAL

ABC6 ACCOUNTS

﻿     |       i



Intentionally left almost blank

ii	 |	 ABC6  Manual



Foreword

When I started writing computer manuals (using a typewriter) 
we were required to supply three books with a software 
package  -- a Training Manual, a technical Reference Manual, 
and the User Manual. These were seriously thick objects as 
they had to explain what a computer was, and give step-by-
step instructions to people who were still waiting for the hard 
disk to be invented. I remember several pages devoted to 
showing typists the difference between their old Remington 
and the keyboard of their new computer.  This was 1979.

A lot of trees are relieved to find that a quarter of a century 
later most software comes with minimal documentation. 
Microsoft’s highly complex program development languages 
are supplied with no paper manuals at all (creating a huge 
market for 3rd party books). I think this is a step too far. I am 
disappointed when I buy a box of software and find it contain 
just a CD  -- all features and options of the program only being 
visible after I install the software.

So with ABC we have provided this User Manual on paper. It 
contains notes to get you started, and reminders for day to day 
operation. We have also supplied a vast amount of other stuff 
-- Reference Manual, Technical Notes, Training Guide, etc that 
installs onto your computer and is available on screen from 
within ABC. I hope this gives you the best of both worlds.

Chris Hicks
chris@abc6.co.uk

These are sample chapters from 
the ABC Accounts User Manual.
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Copyright  
© 2007 
© 2010

 
ABC Direct Sales retains sole copyright and title 
to these programs and documentation. All rights 
are reserved.  
 
You are granted a non-exclusive and non-
transferable licence to operate this software on a 
single computer for your own use.  
 
No distributor dealer or agent is authorised to 
change these terms.

Warning: Limited 
Liability

It is impossible for anyone to guarantee that 
a complex computer program is free of small 
faults (bugs). In addition the results produced 
by a program depend on the information entered 
at the keyboard; and the correct operation of the 
computer system. 
ABC Direct Sales and their agents and 
distributors can accept no liability for the 
use of this program or any direct or indirect 
consequential damages arising from the use of 
this program. 
It is the responsibility of the user of the program 
to check that this program is suitable for their 
requirements; that it is installed correctly; and 
that any results of its use are correct.

Credits Design supervisor: Chris Hicks.

Production details The ABC programs are mostly written in 
Microsoft Visual Basic. This Manual was 
prepared using Adobe InDesign; and ClipMate.  
Manual v1.04 Printed in England. April 2010

FEEDBACK and 
Contact Details

We are keen to hear your comments, bug reports, 
complaints, and ideas for improvements  
(preferably by email).  
 
ABC Direct Sales 
PO Box 203, Sale, Cheshire M33 4XG,    UK  
 
Tel: 0161-282 1270  
email:  feedback@abc6.co.uk  
website: www.abc6.co.uk
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1
Introduction

An overview of ABC 
and how to use this manual

What ABC can do
ABC is a computer program designed to help take care of the bookkeeping 
and paperwork in a small business. Guessing you are not an accountant, we 
have made ABC very easy to use.

In technical terms ABC is an accounts package that can also print labels, 
letters and lists.  All the usual facilities are provided, including Sales 
Invoicing, Statements, Stock Control, VAT Returns, Cashbook, Profit & Loss 
Report, and Audit Trail. A Payroll module is an optional extra.

Computer Expert? or Beginner?
You may be new to computers and worried about which button to press. 
We have made the ABC program quite foolproof (though we know someone 
may invent a better fool). Everybody makes mistakes: it is easy to correct 
these later.  ABC contains lots of features that you may think you do not 
need; ignore those to start with.

After a while you will become a computer expert and want to go faster. ABC 
contains many hidden short cuts for you.

Boxes like this contain hints, 
shortcuts, efficiency tips and 
suggestions. 
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After-Sales Support
A Newsletter is sent out at irregular intervals, containing ideas and 
suggestions collected from other users of this package.

Free technical advice is available by letter or email. Program updates are 
available from our website or by post. page 101

An ABC User Forum (via our website -- page 102) allows you to discuss and 
comment on ABC with other users, and ask for help.

Independent consultants or ABC experts in various areas of the country 
provide after-sales support, training, telephone help lines, etc  for a small 
annual fee.

If you have paid for After-Sales Support, write the telephone number and 
address of your support company in this box for quick reference:

Your computer
ABC should be happy to run on any computer that has Windows XP, Vista 
or Windows7 installed, and a few hundred megabytes of free disk space. 
Ideally your processor speed should be over 2GHz, and you will have at 
least 2GB of RAM. We strongly recommend you have some removable 
device for making backups (eg a USB stick).

It should be possible to use any printer with ABC. If you need to use 
multi‑part ncr sets ABC has an option to print invoices and statements on 
dot‑matrix printers. 
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How to use This Manual
This book is mainly a How to Guide briefly explaining day-to-day tasks, for 
example -- how to produce a Sales Invoice.

General operation of the ABC program is hidden away towards the back 
of the book; and you’ll find pointers to suitable page numbers if  you need 
more explanation ..... eg.    page 123  

It is assumed that you have a working knowledge of the Windows Operating 
System (if not, go and spend 10 minutes learning how to  double-click 
a mouse, start and close a program, and drag the border of a window to 
change its size). 

You may have a fear of boring technical manuals but Please, PLEASE, 
glance through the first couple of Chapters of this book to get an overview 
of ABC and see important step-by-step instructions for getting started with 
Bookkeeping.

Find your way around
Use the Contents List (at the front) or Index (at the end) to lookup the 
subject you are interested in; this should point you to the page.

Technical words are explained in a Glossary            page 113 

Using mouse and keyboard
If you have used Windows for more than a few minutes you probably 
already know these basic principles -- in which case you can look smug as 
you skim through this section.

The mouse moves the mouse cursor on the screen. When the mouse cursor 
is over the item you want to activate, click the left mouse button (ie. press 
and release it). 

To select some text, hold down the left mouse button as you move the 
mouse across the test -- this will highlight that section of text. Whatever 
text operation you choose now will be applied to the highlighted text only.  
Click the mouse anywhere else to cancel the selection.

You can usually change the size of windows, boxes and pictures on the 
screen by dragging their corners or sides. To do this, position the mouse 
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cursor over a corner or side of a box (the cursor will change shape to 
indicate the box is ready to be dragged). Then hold down the left mouse 
button and move the mouse to change the shape.

The right mouse button normally produces a small popup menu of 
functions relevant to the item under the mouse cursor.

If your mouse has a wheel, this can be used for scrolling up and down.

While editing text, a text cursor will show your position in the text. The 
cursor keys can be used to move this around (or you can point to a new 
position with the mouse cursor and then left click the mouse to move the 
text cursor to that position).

press ESC means press the ESC key on the keyboard

click OK means use the mouse and click the left 
mouse button on the OK Button on the 
screen

Enter FORMAT means type the word format, then press 
the ENTER key

Double Click press the left mouse button twice 
(quickly)

Hot Keys
Not everyone likes using the mouse all the time and it is possible to operate 
ABC most of the time using only the keyboard. This is faster and easier 
when entering items into bookkeeping but there are times when the mouse 
is useful.

To indicate to Windows that you are typing a special command, and not just 
another bit of text, you must press one of the command keys at the same 
time; usually the CTRL key or the ALT key. Possibly the most widely used 
keyboard shortcut is CTRL+C to Copy. (hold down the CTRL Key, and then 
also press the c Key)

Most buttons and menus can be operated by pressing the ALT key together 
with a letter of the alphabet. Look at the Menu or button: if one of the 
letters is underlined, that is the one that will activate it. For example, the 
File Menu can be activated by pressing ALT+F.
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Here are some useful keyboard shortcuts (hot keys)

CTRL+C Copy the selected item to the clipboard 
(eg. the highlighted section of text)

CTRL+V Paste the item from the clipboard at the 
cursor position

F1 Press the F1 key for HELP

ESC Press the ESC key to cancel or exit the 
operation.

F5 old ABC users are used to pressing F5 to 
Save (or Finish) the operation, so this still 
works in ABC6.

Close a window (exit)
The standard way to close a window (ie. finish with this operation) is to 
click the “X” at the top right hand corner.  However, sometimes ABC will 
not let you exit in this way. You might have begun entering an invoice. If 
you click the “X”, ABC does not know if you want to cancel (discard) this 
work, or save it part finished.

Before you can exit, you need to click Save or Cancel.

This Manual is a rough guide
The user interface of ABC may change as we continue to work on the 
programs. And you can customise the appearance of many parts of ABC 
and Windows. This means that your screen might look different to the 
pictures in this Manual.

For this reason we have not shown many screenshots and have generally 
just pointed you in the right direction rather than giving exact step-by-step 
instructions. Hopefully this keeps the Manual thin, and prevents it from 
going rapidly out of date.
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How to drive ABC
You can use the keyboard and the mouse to operate ABC. In most cases 
either can be used, and there are often several ways to do something  -- use 
whichever you find easiest.  

The Main Menu
Just about everything in ABC can be reached from the Main Menu (pictured 
below).To display the Menu click the large round button top left of the 
screen (or press ALT+M).

Use the mouse or cursor keys to move around the Menu.  Double-click the 
mouse or press the ENTER key to select a Menu item.

At the top of the screen is a Quick Access Toolbar, and you can customise 
this to add any functions you use regularly. (To do this, right-click on a 
menu option and select Add To Quick Access Toolbar.)

Don’t worry about accidentally selecting the wrong thing.  ABC will make 
you confirm things like Delete this Account.  If in doubt, select CANCEL or 
press ESC (the ESCAPE key). 
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On screen HELP
ABC includes an on-screen Manual that you can view at any time:   press 
the F1 key, or click a Help button, or select Help from a menu.

The on-screen Manual contains several Sections, including an Introduction, 
Reference Section, Guided Tour of ABC (for beginners) and Operator Notes. 
Each Section contains several Chapters. An example Page (explaining the 
ABC Message Box) is shown below. While viewing any Help Page you can 
call up the full Contents of the on-screen Manual in a separate Window -- 
click the Contents tab (or press ALT+C). See below.

Help Pages contain links to other Help Pages: click on the underlined words 
to follow the link (and then click BACK if you want to get back to the 
previous page).

You can search the on-screen Manual by choosing Index or use Find to see 
all Pages containing the word(s) you are interested in.

While you are using ABC, if you request Help (press F1 or click Help) the 
program will usually be able to open the on-screen Manual at a relevant 
page (this is known as context sensitive Help).

The Help System remembers Pages you looked at recently, and you can use 
the < and > keys to step backwards or forwards through these Pages.
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Starting up ABC
From Windows desktop click on the ABC shortcut

If the Password system is turned off, the Main Menu will appear. Otherwise 
you need to Log-On by entering your Password.

Log On to ABC
Enter your own password.

To set up or edit Passwords (page 76) ABC may ask for your 
Registration Key (page 102)
 
The Noticeboard may appear; you can Continue, or Edit the 
messages, Print on paper. The NOTICEBOARD is a useful 
place to leave notes for the next person to use ABC. You can 
turn it off  (page 97)

Log Off from ABC
Whenever you have finished using the program, you should always close 
down properly to ensure files are closed and all information is written 
safely back to disk. Never switch off the computer without first closing 
down ABC.

If you are just leaving the computer for a few minutes, or couple of hours, 
then you should Log-Off.   

Change to different Company
If you have more than one set of accounts set up in ABC, go back to the 
Main Menu and Log-Off, then  Log-On to a different Company.
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Customise your ABC
Many parts of ABC can be changed to suit your own preferences, including 
screen colours, screen layout, passwords, report content and quick access 
Menus. The OPTIONS MENU (top right of the screen) has many of these 
functions. Buttons at the bottom right of the screen will change the screen 
layout from multiple windows side-by-side, to having them one above 
another.

To add a function to the Quick Access toolbar (top left of screen) right click 
on a menu item and select ADD TO QUICK ACCESS TOOLBAR. 

Set your company details
You need to set your company name and other details before starting to use 
ABC for your real accounts.   Page 75 

Bottom left of the screen always shows the current bookkeeping month and 
accounts year start. If you use ABC for more than one company’s books the 
current company name is displayed near the top of the screen.

Other functions of ABC
ABC is unusual amongst Accounts packages because it also lets you write 
letters, produce labels, design your own reports, produce spreadsheets, etc.

Later chapters describe these options. Don’t bother learning about things 
that you do not need. However, if you find you are spending time every day 
over some repetitive task (eg. producing address labels for parcels), look to 
see if ABC can help.

If you cannot see how to get ABC to save you time on some task, contact 
your After-Sales Support company, or ABC Direct, with details of what you 
need to do. Usually we can help

The TOOLS MENU (top right of the screen) contains functions like Update 
ABC, Visit the ABC website or User Forum, and display Version number, 
and enter your Registration Key.
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Get started with Bookkeeping
ABC is designed to save you time and effort in looking after the mass of 
paperwork that is the bookkeeping in every small business.

At its simplest you can just enter details of everything you buy or sell, 
money received or paid. At the end of each month ABC can automatically 
produce neatly typed double-entry account books  exactly like a perfect 
hand-written system (but without the effort).

Take these books to your accountant at the end of year, and they will sort 
out depreciation, prepayments and accruals, assets, etc. 

Notes for Accountants: The emphasis in ABC is low level bookkeeping, and 
on screen we have hidden the complexities of accountancy. However, ABC 
is a full double-entry accounting package and could produce final accounts. 
(page 74).

Don’t trust computers!
Beginners (and some experts!) often think that anything printed out by a 
computer must be correct. This is not true! The computer is only a large 
calculator; if somebody enters a wrong number, the answer will be wrong. 
If your neighbour operates an arc-welding unit, a surge through the power 
supply can make your computer turn out nonsense.

The thing to bear in mind with any computerised accounts system is, 
computers and computer operators CAN make mistakes. So you must check 
everything.

You can easily print out on paper and then glance through to see if totals 
look reasonable. This allows you to check what is happening all the time, 
and you have your account books not only in the computer, but on paper in 
black and white.

Don’t keep separate handwritten books!
Everyone will advise you to run a new computer accounts system in 
parallel with your normal bookkeeping for a few weeks or months, to make 
sure it is working correctly. This advice is correct in general, BUT with 
ABC you can do this without having to do all that handwritten paperwork 
yourself. Here’s the secret:

Enter into ABC details of everything you buy and sell. Print the reports on 
paper. Now treat those pieces of paper as your handwritten account books, 
and check them carefully.

10	 |	 ABC6 User Manual



In the absolute worst case (eg. your computer goes wrong) you are still 
better off! A Sales Daybook is a list of invoices with a total at the end no 
matter whether it was produced laboriously by hand, or printed out in 
seconds by a computer. 

Another factor is that if you do keep a separate set of books, it is often 
difficult to get exact agreement with the computer. You can end up wasting 
hours to find why the computer total is a penny different (often due to a 
mistake in your manual adding up). It’s much better to spend a fraction of 
that time on double checking the paperwork produced by the computer. 
You’ll achieve the same result.

If you are in doubt about this advice talk it over with your accountant. We 
are happy to speak to accountants about the best way to use ABC.

After the first few weeks
Once you have got used to working as described above, please continue to 
do this. Just because things appear to be OK for a few weeks, don’t assume 
everything will work perfectly for ever.

A typical month’s bookkeeping
During each month you would produce sales invoices on the computer 
using the Sales Ledger and enter details of unpaid bills into the Purchase 
Ledger. Collect together all petty cash receipts and other miscellaneous bits 
of paper (eg. till rolls) and enter these into the CashBook. You can do this 
each day, or every few days, whenever it is convenient.

When you receive a cheque (or cash) in payment of a sales invoice, enter 
this into the Sales Ledger (so you can mark the invoice paid) and not into 
the CashBook. When you pay a supplier’s invoice, start by telling ABC you 
have paid that invoice (in the Purchase Ledger) and the computer will then 
show you how much to write on the cheque and can print a Remittance 
Advice to send with it.

It is best to have entries approximately at real dates 
(ie do not get too far behind in your entries). It is a 
good idea to run the ABC Month End function within 
a few days of the real end of Month even if it means a 
some late items get entered into next month instead.
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At the end of the month you can start producing sales invoices with next 
month’s date, while still entering unpaid bills from suppliers. Most people 
run the Month End routine about a week into the next month. Before doing 
this, have a final check that you have entered everything into the computer 
from this month. Go through your bank statement and enter any bank 
charges or standing orders.

Then select the MONTH END function. This can be customised to 
automatically print out a lists, in the form of double-entry account book 
pages, of everything you entered during the month. (though these days 
many people save paper by not printing anything out unless it is required) 
That is the minimum you need to do!

ABC has taken care of all the calculations, adding-up columns and 
separating out the VAT.

If you wish you can do much more, for example print out useful Trading 
Reports at any time showing an analysis of your profit and loss.

More than one way
There often are several ways in which you could enter something into 
ABC Accounts. For example, if you cash a cheque at the bank  and put the 
money in your petty cash tin, this could be entered into ABC in one of three 
ways:

xx 1. Cashbook PAYMENT (cheque paid from the bank)

xx 2. Cashbook RECEIPT (cash received by petty cash tin)

xx 3. Nominal Transfer (amount transferred from bank to petty cash)

Any of these will work OK. (Method 1. is preferred because it allows you to 
enter the cheque number into the correct place)
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2
Getting started

Setting up the Accounts 
General Notes about VAT

Introduction
It is important that you set up ABC correctly to suit your business before 
you start using it to do your bookkeeping. For example, check that the VAT 
rates are set correctly, invoice numbers are set to the required start number, 
your Company Name and Address details are entered, and that any dummy 
information has been cleared from the files. Use the checklist below:

If you create an extra company at any time, you must 
follow this procedure to set up that Company, before 
starting to use it. 
If you are upgrading from an earlier version of ABC, 
the IMPORT function will take care of most of this 
automatically  (page 24)

RR 1. Set up Analysis Headings (Nominal Ledger Accounts) page 15

RR 2. Clearout any dummy information from the files 
and set your Accounting Year and the current Accounting Month. 
Set Folio Numbers. Also specify if you are VAT Registered.  page 18

RR 3. Enter your Customer and Supplier names and addresses. 
If you have been trading for a while there will probably be invoices 
already outstanding with these companies so you can choose to 
enter the amounts as Opening Balances.       page 19.
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Set up some Analysis Headings
The Analysis Headings (our word for Nominal Ledger accounts) are the 
centre of the Accounts system, and hold details of vague things like assets, 
profit, VAT, bank accounts.  Americans call it the  General Ledger, whereas 
in the UK it is the Nominal Ledger.

Think of the Nominal Ledger as a book with nine chapters. Chapter one is 
for Sales, Chapter four is for expenses, Chapter eight is for Current Assets, 
etc. Each Chapter is split into sections  for example Chapter four (expenses) 
might contain sections for Gas, Electricity, Postage, Insurance, Bank 
charges.

With a handwritten ledger the usual way to show these sections is with 
columns;  one column for Gas, one for Electricity, etc. The title or name 
of each column being written as a heading for the column. Splitting your 
expenses up in this way allows you to analyse your business  see at a 
glance what you are spending on each item. In ABC we call these sections 
(ie. columns) Analysis Headings. (Accountants think of them as Nominal 
accounts).

The advantage of the computer is that you can create as 
many Headings as you need and analyse your business 
just how you choose 
 
.

Each Heading is given a unique number;  those in Chapter one have 
numbers between 1000 and 1999, those in Chapter four between 4000 and 
4999. Some sample Headings (Nominal accounts) could be:  4223--Gas 
expenses, 4325--Telephone charges.

Before you start using ABC, you need to set-up the Headings to suit 
your own type of business. You don’t have to get this perfect first time, 
because you can alter things later; but it is sensible to get the Headings 
approximately correct before you start making entries.

We suggest you print the existing list of Headings (page 68), and work just 
on paper until you are satisfied you have a suitable list of Headings (an 
accountant might call this a Chart of Accounts).page 14.

Nominal Ledger > Print List of Headings
It is a good idea to talk to your accountant about this, and you do not need 
to use the computer at all; just pen and paper. A copy of last years accounts 
would provide a good starting point.

Getting started     |       15



It is easy to add more Headings later, if you find you need greater analysis 
of certain parts of your business. But it is difficult to delete Headings after 
you have used them (it upsets the audit trail). As a general rule, therefore, 
you should start off with very few Headings, and only add more when you 
really need them. Do not create a separate Heading for each Stock Item -- 
that analysis is better done using the Stock System.

Analysis Heading Groups
The Analysis Headings are divided into 9 Groups (chapters)

Group  Category of Headings (N/L Accts)  Db or Cr

1  SALES or INCOME.  Credit

2  OTHER INCOME  Credit

3  PURCHASES and COST of SALES  Debit

4  EXPENSES & OVERHEADS  Debit

5  CAPITAL EMPLOYED  Credit

6  LONG TERM LIABILITIES  Credit

7  FIXED ASSETS  Debit

8  CURRENT ASSETS  Debit

9  CURRENT LIABILITIES  Credit

ABC takes the totals of these groups and uses them as follows: (You can 
rename the groups, though that won’t change their function).

Gross Profit  =  Group 1 - Group 3

Net Profit  =  (Groups 1 + 2) - (Groups 3 + 4)

Turnover  =  Group 1

Liabilities  =  Groups (5 + 9 + 6)

Assets  =  Groups (7 + 8)

Working Capital  =  Groups (8  9)

Note for Accountants: 
An Analysis Heading is what ABC calls a Nominal 
Ledger Account. 
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Analysis Heading Numbers
Each Heading is numbered (think of it as the Account Number) and this 
number determines the properties of this Heading.

Analysis Numbers can range from 1000 to 9999

Headings in Group 1 have numbers beginning with 1.  
Headings in Group 2 have numbers beginning with 2, etc.

To make your Trading and Balance Sheet printouts look 
prettier (and to create sub-divisions within Groups) you 
can use some Headings as Group Titles, Sub-titles, and 
Totals. These sub-title and total Headings cannot be 
used for entering money; they are purely cosmetic.

Numbers ending in 000 are main group titles. 
Numbers ending in 00 are sub-titles. 
Numbers ending in 0 are titles of sub-divisions. 

Numbers ending in 999 are main group totals. 
Numbers ending in 99 are sub-totals. 
Numbers ending in 9 are totals for sub-divisions.

For example, Number 1000 is Main Title for Group 1

All other Numbers are normal Headings, and can have amounts of money 
entered against them.

For example, 8411 is Bank Account 1

The Subtitles and Subtotals allow you to divide your 
business up into departments if required. You could 
ignore these for now and add some later if you need to. 
 
.

Examine a List of Headings (page 14)  you will see how the titles and totals 
Headings appear, determined by their number.

If you add a new Heading to your list, give it an appropriate number. It is a 
good idea to leave a few gaps between numbers in case you decide later to 
add some further Headings in this area.
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Clear the Accounts Files
The installation disk may contain some dummy information to let you 
experiment with the Accounts system. When you are ready to start using 
ABC for your business, you must clear out all the Accounts Files.

Accounts Utilities  >  Rarely used  > Clear the Files
There are several stages to this process and you can complete them in any 
order. 

xx Choose ALL DATA (clear out Customer names/addresses also)
or CLEAR FIGURES ONLY (just set the amounts to zero).

The Headings (Nominal) descriptions are not cleared 
but the Heading balances are all set to zero. 
If you want to delete any Headings, this is the time to 
do it (while they hove no transactions). 
.

xx Select a set of Analysis Headings (Nominal Ledger Accounts) for your 
business. You can retain the existing set, or choose one of the presets 
included with ABC.  You will be able to modify these later, so do not 
worry too much about it at this stage.

xx Set the starting Sales Invoice number, Purchase Folio number, etc. If 
you already have a bookkeeping system, you might choose to carry on 
with the same number sequence, or you could start from 1 (or from 
1000). page 21

xx Enter the Year & Month of the start of your accounting year.

xx Enter the Year & Month in which you wish to begin using ABC. This 
must be within your Accounting Year.

xx Are you registered for VAT?  
If you are, then also enter your VAT Registration number.
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Set-up Customers and Suppliers
CAUTION regarding VAT: If you need to enter details from your old 
handwritten bookkeeping system into ABC, think carefully about the VAT 
involved in the old invoices. Either handle it outside of ABC (manually) 
or enter it into ABC and let ABC take care of it completely. Do not do 
both! (There is only one thing worse than paying VAT; and that is paying it 
twice!!) See item 3. below. Discuss this with your accountant if in doubt

It is not essential that you enter all your Customer and Supplier names and 
addresses into the computer before you start using ABC because you can 
add new records at the time you enter invoices. You might choose to ignore 
this section completely. However, if you want to enter your Customers and 
Suppliers first, here is what to do:

1. Prepare a list on paper of existing customers and suppliers. This does 
not need to be in alphabetic order.

2. Add the new Customer and Supplier Records (page 26) 

You can add these records in any order. You can enter 
them all or just do some now and the rest later; or add 
new customers at the time you invoice them. 
 

3. Choose from 4A, 4B, or 4C for how to enter old invoices. Method 4C is 
best (but involves most work). Most people probably use method 4B. 
If you are just starting a new business, then 4A is your choice.

4A. Do Nothing!  You are starting with blank files. (If you do have any 
invoices from before you started using ABC, you must continue to 
handle them by your old manual bookkeeping system -- they are 
nothing to do with ABC. Remind your accountant to combine those 
old invoices with the ABC books to produce your final Accounts at 
year end).

4B. Enter an Opening Balance. Instead of entering all the details of what 
a customer owes you, just enter the total amount (and this figure is 
put as the Opening Balance on their Account). One complication is 
that you must separately take care of any VAT relating to those old 
invoices. (If you are using the Cash VAT Accounting method, sorting 
out the VAT may be complicated -- you might find it simpler to use 
4C instead!!). 
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By just entering Opening Balances to Customer/Supplier records you 
are ignoring the VAT (this was accounted for at the time the original 
invoices were raised).  You have two choices for handling the old 
VAT:  
 
1.  Do it outside of ABC (eg by hand).  
 
2.  Work out the amount of VAT and enter this as an Opening  
      Balance to Heading 9211 -- VAT Control Account in the  
      Nominal Ledger (page 53)  
 
Decide on a starting date, usually the 1st of that Month you entered 
as the starting month. (page ) Calculate the balance for each customer 
and supplier AT THAT DATE. This will be their Opening Balance; 
enter it into ABC.

 4C. Enter all the old invoices into ABC. ie. go back in time a few 
months, and enter all the individual original invoices; ie. duplicate 
the manual system. You do not have to print these invoices when 
entering them but it might be useful. (page 61) If you do not have too 
many old invoices, this method is the best one to use.

ABC is very flexible. You may choose method 4C for some of your 
customers, but 4B for others. Just remember that once you have 
entered something onto the computer, you must account for it. If you 
enter invoices with VAT, you must at some stage also enter details of 
payment of that VAT to the government.

5. You can print on paper to make it easier to check what you have 
entered. Look at the reports to see the figures you have entered. This 
is a very good way of learning how a bookkeeping system works. 
For example, examine the List of Customers report and Aged Debtor 
report (page 64)

To correct mistakes in the Customer name/address 
details edit the Customer Record. (page 26)  You 
cannot directly edit the account balance so if you need 
to adjust the figure enter an Opening Balance (as a 
positive or negative amount).
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Company name and address
Fill in your own Company name and address details. These will be printed 
on reports (including invoices and statements) so take care to get everything 
correct (though you can edit them at any time).

Accounts Utilities >  Edit Company Parameters
You can view or edit the next Folio/Invoice Number (page 75), and the Logo 
(small picture) that prints at the top of reports. (page 75)

                       FOLIO NUMBERS
ABC automatically generates a unique Folio Number 
for each transaction you enter. These folio numbers 
then appear on all reports, audit trails, etc, making it 
easier to track the transactions. There are 5 sets of folio 
numbers: 
SL - Sales Ledger Invoices 
PF - ProForma Invoices 
PL - Purchase Ledger Invoices (Unpaid Bills) 
CB - CashBook entries 
JN - Nominal Ledger Journal entries. 
Normally you should not alter these during the year.

Check the VAT rates
Accounts Utilities  > Rarely used > Edit VAT Rates

Whenever you enter a transaction into ABC you must specify which VAT 
rate applies by selecting one of the following VAT Codes. Do not edit the 
percentage rate unless the Government has changed the VAT rates.

Code  Rate  Notes

0  Zero rated goods books, food; also exports

1  Standard rate (eg. 17.5%) most sales and purchases

2  Alternative rate 2

3  Alternative rate 3

4  EC zero rate

5  EC Standard rate most EC sales and purchases

6  EC Alternative rate

E  Exempt from VAT

N  Not applicable internal transfers, wages
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VAT  General notes 
There will be occasions when ABC queries the VAT Amount you entered 
because it does not exactly agree with the expected amount.

a) If you have made a mistake, then change your entry.

b) If you had a valid reason for entering this VAT Amount (see next 
paragraph), then you can select Continue.

Mistakes involving VAT
If you spot an error on the piece of paper you are entering into ABC:

(1) If you created this piece of paper (for example, a Cash Sale Receipt), 
and no copies have been given to anyone else; then you can tear up 
the paper and create a corrected version.

(2) If you have already sent someone else a copy of this piece of paper, 
or if you are entering an invoice or receipt from a supplier; then you 
must enter the incorrect figures into the computer exactly as they 
appear on the paper. 

Sales Invoices - cosmetic adjustment
VAT can be worked out line-by-line or calculated on the invoice total. 
ABC uses the line-by-line method (as this allows you to mix VAT rates on 
the same invoice), but humans usually use the invoice total method. Both 
methods are acceptable, but could give slightly different results (eg.a few 
pence difference). This may worry your customers if they check the invoice 
using the other method.

ABC tries to be smart! If all lines on the invoice have the same VAT rate, 
then the program will try to adjust the VAT total so that the line-by-line 
method gives the same result as the invoice total method. The small 
adjustment is made to the first line of the invoice. It should be stressed 
that this is being done purely for cosmetic reasons; the VAT Inspector will 
accept either method.

Cash VAT Accounting
ABC automatically allows for Cash-VAT-Accounting (the system where you 
do not have to pay VAT to the government until your customer pays you). 
There is nothing you need to do differently in ABC whether you use Cash-
VAT or normal Accounting.
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Print the VAT Return 
You can choose a standard VAT Return, or the Cash-VAT Accounting 
Return (which includes some additional pages showing how ABC arrived 
at the results). In either case, you should check the figures carefully before 
entering them onto your actual VAT 100 Form and signing it. page 68

A full VAT Audit Report can be printed, listing all the transactions 
containing VAT within the date range you specify. VAT Returns can be 
reprinted for past periods.

Notes for the VAT Inspector
ABC can produce an audit trail of everything that has been entered during 
any specified period; and this can be printed on paper for easier inspection 
or record keeping.

Every report has a separate column for VAT, with a summary at the end. 

The ABC VAT Return lists VAT transactions during the period, followed by 
details of any calculations or adjustments to those figures. Finally, the last 
page shows the entries required on the VAT 100 form. 

Please contact ABC Direct Sales if you have any queries or wish to discuss 
ABC   (page iv)
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Import from ABC5
ABC includes a function to import all the Accounts data from your old 
version of ABC5. This process does not affect the ABC5 files at all, and you 
could continue to use the old ABC5 for a while. This function can be used 
at any time, and you can use it more than once if you wish.

If you have more than one Company in ABC5 then 
first you must create a corresponding new Company in 
ABC6 and then ensure you are in that Company before 
using Import. You need to do the Import separately for 
each Company.

Accounts Utilities > Rarely Used > IMPORT FROM ABC5
Select which of your old ABC5 Companies to import from (if you have more 
than one). The Import process may take a few minutes if you have a lot of 
history. While importing the data, ABC6 will check the records and will 
skip any damaged or deleted records. Check the text in the progress box on 
screen for a report on what has been imported. 
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3
Record cards

Add new Account Record Cards 
Edit existing Accounts 

Customers  Stock Items  Headings

ABC keeps a Record Card for each Customer Account, to store their name, 
address, balance, history, notes, etc. The Record is split into several tab 
pages (see example above).  Similarly there is a Record Card for every 
Supplier, Stock Item, and Nominal Account (Analysis Heading).

This chapter explains how you can view or edit existing records, add new 
records, or print a record. Full details are given of the information that is 
stored in each Record Card.
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Customer and Supplier Records
Supplier and Customer Record Cards are identical, so this section applies 
to both. Select Sales Ledger for Customer Records, or Purchase Ledger for 
Suppliers:

Sales Ledger > Customer Records

We talk about the Customer Record Card  but an 
accountant will probably call it the Customer Account. 
(and a programmer might think of it as one Row in the 
Customer Table.) 

The list panel to the left of the Card allow you to find a particular customer 
and then view or edit their Record Card.       (page 105)

Create New Customer Record
Select ADD from the ribbonbar.  A blank Record Card is displayed. Fill in 
the name and address details as explained below.

Edit or View Customer Record
Find the Customer Record that you require. Select EDIT from the ribbonbar 
if you want to change anything (page 106).

Some Fields are updated automatically by ABC and you cannot change 
them (eg. the Account Balance).

Details of each Field
The Customer (or Supplier) Record Card has Fields for the name, address, 
credit limit, balance and other details. Each Record Card has several tab 
pages containing groups of Fields (described below). Many of the Fields can 
be left blank -- you can edit them later if required. 

Field Name Description and Notes

Account 
Number

This is generated by ABC to ensure each customer has 
a unique account number. You cannot change this.

Key This is just a shortcut or nickname for the Customer 
that you can use to quickly locate their Record. 
Enter any code or abbreviation; or leave it blank and 
ABC will fill in the first few letters of the name as a 
suggestion.
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Field Name Description and Notes

Company 
Name Address 
and Postcode

Enter the business name and address of the Customer 
(Supplier). ABC will use this when printing 
statements, invoices or letters, so check it carefully. 
The EC Field is a 2 character European Country code.

Telephone and 
Contact Name

ABC will use this when printing a list of Customers 
(or Suppliers) and Aged Debtor Lists.

Mobile 
phone and 
fax numbers. 
Email address

 Can all be left blank if not required.

Current 
Balance

The total amount owing on this account at this 
moment. You cannot directly edit this Field. When 
you enter a bookkeeping transaction (for example 
an Invoice or Money Received) ABC will update the 
Balance.

Year to Date The total amount of trading for the current 
bookkeeping year, up to today’s date. ABC updates 
this automatically.

Credit Limit ABC will warn you during invoicing if the account 
balance is approaching this Credit Limit (you might 
then choose to ignore the warning..... that’s up to 
you!). If you leave it blank (or set at 0) then ABC will 
not check the Customers credit limit.

Previous Year 
total

You can leave this blank. Or you can fill in an 
approximate total of how much business you did with 
this Customer (Supplier) last year (excluding VAT). 
ABC will automatically update this Field during the 
Year End.

Last Invoice 
Month

ABC automatically updates this field with the 
bookkeeping month number (eg 201103 for March 
2011) of the last time you sent/received an invoice.

Last 
Transaction

Leave this blank. ABC will keep this field updated 
with the date of the most recent transaction for this 
Customer (or Supplier)

Unallocated 
and 
Overdue 
(indicators)

If this Customer (Supplier) has a money or credit note 
item over 30 days old and not paid, the indicator will 
glow red. Even if the Balance is zero because you have 
entered their payment, the indicator will glow to show 
that items are not yet allocated (marked paid).
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Field Name Description and Notes

History or 
Outstanding

The grid (table) will display the transactions for this 
Customer (Supplier). You can choose OUTSTANDING 
to see only the unpaid items; or HISTORY to see 
everything.  Right-Click an invoice to Zoom or reprint. 

Note 1 A single line of text for your own use.

Note 2 A single line of text for your own use.

Note 3 A single line of text for your own use.

Memo This can store a large amount of text (many hundreds 
of lines).

Customer Ref If the Customer refers to you by a code or account 
number; you can enter it in this Field. This can be 
printed on sales invoices.

VAT 
Registration

The Customers VAT Registration number; as required 
for reclaiming EC VAT.  Can be left blank.

Delivery 
Address

The Customer might have different addresses for 
deliveries and for invoicing. ABC allows you to store 
several different delivery addresses for each Customer.  
Leave this Field blank -- ABC will automatically fill 
in the code of the last Delivery Address used for this 
Customer. (You can edit the Delivery Addresses while 
producing a Sales Invoice).

Agent For your use (or used by Sales Order Processing)

Type of 
accounting

You can specify Open Item or Balance Forward 
accounting for the Customer. The default is OPEN 
ITEM (which is what most people prefer).

Settlement 
Discount

Tick this box if you wish the Customer to be offered 
your standard Settlement Discount on sales invoices. 
See page for more details.

Cash with 
Order basis

Tick this box if you do not want to allow this 
Customer any credit (ie. they must pay cash for any 
goods or services)

VAT Inclusive 
prices

If you tick this box ABC will assume that all prices 
entered when invoicing this Customer are VAT 
Inclusive:  ABC will  then deduct the VAT to show the 
Goods and VAT separately. This is useful if your goods 
are marked with retail prices. 
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Field Name Description and Notes

Price Group The Stock System can store 3 different prices for 
each item. When invoicing this customer Price1 will 
normally be used. If you tick the Price Group 2 box, 
or Group 3 box, then Price 2 or 3 will be used when 
invoicing this customer.

Trade 
discount

If this Customer nearly always has a trade discount 
then you can enter the discount percentage here, 
eg 10%. ABC will use this as the default when you 
invoice this Customer.

Terms For your use. eg.  Strictly Nett. Payment within 30 
days. These terms can be printed on Sales Invoices.

View or Print
While looking at a Customer (or Supplier) Record; you can view or print 
a Statement (list of all unpaid items) or History (list of every transaction 
-- you can specify a date range). Other options on the View/Print Menu are 
address label, mail-merge letter, envelope. 

If you want to print details of ALL (or several) Customers; then select a 
Report from the Sales/Purchase Ledger Menu -- eg. to print Statements for 
all Customers with outstanding items (page )

Reprint (or view) old  Invoice
Right-click on an invoice in the History/Outstanding Grid, and select Zoom 
to view or reprint.

Delete a Record
Edit the Customer (or Supplier) Record Card, and tick the box “Marked for 
Delete” on their Options Page. The Record will not be removed immediately 
-- ABC will wait until it is safe (from an accounting point of view) and that 
may take a year or so. Customers that still have any outstanding item will 
never be deleted.

To undelete a Customer Record edit the Record Card 
and untick the MARKED FOR DELETE box on the 
Options tab page. 
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Analysis Heading Records (Nominal Ledger Accounts)
The Nominal Ledger is for details of vague things like assets, profit, VAT, 
bank accounts. Also known as the General Ledger. (page 15)

ABC keeps a separate Record Card for each Nominal Account (Analysis 
Heading), as shown below.

Create a new Nominal Account (Heading)
Select ADD from the ribbonbar. A blank Record is displayed. Fill in the 
details (see next section).

It is very easy to add new Headings at any time, but not so easy to delete 
them (without upsetting the Audit Trail). Our advice is to only add a new 
Heading if you really need it.

Edit a Heading Record Card
Find the Record Card you require (page 105) and select EDIT. 

You may find it useful to print a List of Headings on paper (page 68).

For hints and tips on editing Fields, page 106.
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Details of each Field

Field Name  Description and Notes
Heading 
Number

Also known as the Nominal Account Number, or Heading 
Code. Each Heading Record must have a unique number.

Short 
Description

 A brief title for this Heading. This will be used where there 
is not space for the full description (below). eg MTB Ladies

Full 
Description

The full title for this Heading (Nominal Account) eg. Sales 
of Mountain Bikes (Ladies Size)

Current 
Balance

The total amount that is in the Account at this moment. 
Only ABC can change this Field.

Month to Date The total of all transaction entered into this Heading during 
the current bookkeeping month. Only ABC can change this 
Field.

Start of Year 
Opening 
Balance

The figure that was in this Heading at the start of this 
bookkeeping year. This should be zero for all Trading 
accounts (eg Sales, Purchase Expenses)

Budget For your own use. For example; you can print a report 
comparing actual balances with budget figures. Can be left 
blank.

Debit or Credit Depending on the type of Heading this is; ABC displays 
whether it is a Credit or Debit account. (only an accountant 
could be interested in this)

Type of 
Account

The Headings (Nominal Accounts) are divided into 9 
categories or types. (page 16). ABC fills in this field 
automatically.

Last Year For the Trading accounts (eg. Sales) ABC keeps a note here 
of the total entered into this Heading last year. 

This Month 
or All 
Transactions

The grid (table) displays the transaction history for this 
Heading. You can switch between viewing this months 
transactions

Headings with Analysis CODES above 5000 are Balance 
Sheet Headings and the Last Year figure becomes 
the Opening Balance figure for this year; you are not 
allowed to alter this. 
 
Headings with CODES below 5000 are Trading 
Headings and you can enter a Last Year total for 
comparison  or use it as a budget figure. You can edit 
this.
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Delete a Heading Record
Select Delete from the ribbonbar. Some Heading Records cannot be deleted 
because:

a) some Headings are used by ABC for automatic postings. These include: 

1971 Sales Discounts 8395 Contra Payments

3971 Purchase Discounts 8411 Bank account 1

3981 Stock adjustments 8471 Petty cash tin

5111 Trading Profit C/F 8481 Money on Premises

5281 Opening Balance 9111 Purchase Control

8111 Sales Control 9211 VAT Control

8121 Stock Value 9221 PAYE Control

b) Headings that have an amount in the  Balance Field, or which have 
been used recently, cannot be deleted.

Also, the Group Title and Group Total for a Group,  ie. Headings 1000, 
1999, 2000, 2999, etc, cannot be deleted.

Although you cannot delete these Headings, you can 
change the descriptions to better match your own 
business. 
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Stock Record Cards

Introduction
Some people use the word Inventory instead of Stock. 
Each stock item is given a Record Card in the Stock File to store details like 
description, quantity in stock, and price. 

Some businesses may not need a stock control system but you can also use 
the Stock Records for keeping “text-only” Records to store commonly used 
phrases or notes. These can then easily be used on Sales Invoices when 
required.

For a proper Stock System to be useful, you must keep it up to date and 
enter everything that goes in or out of stock.

The ABC Stock System has some more advanced features (generally hidden 
away on the Options Tab Page). For example you can specify the Cost Price 
and Markup percentage, and ABC will calculate the Selling Price (with and 
without VAT). And you can ask ABC to warn you when invoicing if the 
stock level of this item is getting low. 

Stock System > Stock Records
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Add new Stock record
From the ribbonbar select ADD.

A blank Record Card is displayed, and you can fill in details of a new stock 
item (see below). Give each stock item a unique Code.

The Stock Code can be used when creating a Sales 
Invoice to call up a stock item into the invoice so 
choose Codes that are meaningful and relevant to that 
item. 
 

Edit Stock record
Find the stock item you require (page 105) and select EDIT from the 
ribbonbar.

Hints and tips on editing Fields, page 106.

The Stock Record Card has Fields for the description, cost price, selling 
price, etc. These are spread across several tab pages, and described in the 
following table.

When you SAVE the Stock Record,  ABC can recalculate the Selling Prices 
or Markup if you wish. You can set your preference on the Options tab.

Details of each Field

Field Description
Stock Code Any code or number. It must be unique. You will use this to 

quickly call up the stock record; so we suggest you choose 
codes that are short, meaningful and easy to remember. Up to 
16 characters.

Description 1 
and 
Description 2

A description of the Stock Item. This can appear on printouts 
and Invoices. The Description 2 Field allows you to have 
an alternative description, perhaps for Price Lists or trade 
customers.

Qty in Stock The number of units you have in stock. ABC will 
automatically update this Field; you cannot edit it directly.
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Field Description
Quantity on 
Order

You can enter the quantity of units that you have already 
ordered. This is to stop the computer constantly telling you to 
re-order an item that is already on order.

Allocated The quantity of units you have sold but do not have in stock 
ie. on order and reserved for someone.

Location It may be useful to specify a shelf or warehouse location. 

Case 
Quantity

How many units in one case or outer. You can leave it blank if 
you don’t need this feature (or enter 1 )

Selling Prices 
(Excluding 
VAT)

The Selling Price excluding VAT. If you leave this blank, ABC 
will calculate it from the Unit Cost price and the markup 
percentage. You can have three different prices for each stock 
item. (On the Customer Record you can specify which Price 
Group should be used for that Customer: 1, 2 or 3.) page 29

Selling Prices 
(Including 
VAT)

The Selling Price including VAT. If you leave this blank the 
computer will calculate it as above, adding on VAT at the 
current rate dependent on the VAT CODE Field.

Case 
Discount

Enter either a fixed amount or a percentage (eg. enter 5% )

Sales 
Heading 
Number

The default Sales Heading this item will be analysed under 
when invoicing. (but you can change it)

VAT Code Specify the VAT Code that normally applies to this stock item. 
If you leave it blank, it defaults to Standard Rate.(Vat Code 1)

Sales Dept. The default Sales Department Code this item will be analysed 
under when invoicing.

History Page This Page displays a table showing all transactions involving 
this Stock Item. You can view just this month, or the full 
history. You can also choose whether to only look at Invoiced 
items, entries made using Stock IN or Stock OUT, or both. 

Unit Cost The unit cost excluding VAT. This is used for automatic 
calculations and valuation reports. All quantities in the rest of 
the Record Card relate to units.

Case Cost If the units arrive packed in outers of 20 for example, then you 
can use this feature. If you purchase units individually, leave 
this blank (or enter the cost of 1 unit)

Supplier 1 
and 2

You can note your main Supplier and a second source here. 
This information is just a note for you. The computer does not 
use it for anything; except to show on reports.

Purchase 
Heading 
Code

The default Purchase Heading Code this item will be analysed 
under when entering purchases. 

Record cards     |       35



Field Description
Purch. Dept. The default Sales Department Code this item will be analysed 

under when invoicing.

Re-order 
Quantity

When you need to re-order this item, how many units do you 
normally order? This will be shown on the RE-ORDER LIST

Last-In Cost For comparison when next you re-order.

Type of Stock 
Item

A Stock Record can contain a NORMAL item (eg. some goods 
or service; with a price); or just some text -- TEXT ONLY. The 
difference is that ABC automatically adjusts the Qty In Stock 
Field as you buy and sell Normal Items but does not do this 
for Text Only Items.

Low Stock 
Warning

When producing a Sales Invoice; ABC can warn you if the 
Stock Item you enter is out of stock. This warning can be 
turned ON or OFF for each Stock Record. If a Stock Record 
is Text Only (see above) then the Low Stock Warning is 
automatically turned OFF.

Minimum 
Quantity

The lowest quantity of units that you require normally to have 
in stock. The NEED RE-ORDER LIST will show you all Stock 
Items where the Quantity in Stock is below this Minimum 
Quantity.

Method For your own use

Recalculate 
Prices or 
Markup.

You can specify whether you wish ABC to automatically 
recalculate the Selling Price (from Cost Price X Markup) or the 
Markup % (from Selling Price/Cost Price).

Month to 
Date Sales 
(MTD)

The number of units that have been sold this month, at each 
Price Group. Normally you would leave this blank, and ABC 
will fill-in the figures as you produce invoices.

% Markup You can specify how much profit you wish to make on this 
stock item and ABC will use this figure to calculate the selling 
price (if you leave that Field blank). Alternatively, leave the 
Markup % blank and ABC can calculate the percentage from 
the Selling Price and Cost Price

Delete Stock record
From the buttons under the Record Card select DELETE.

If you have used (eg. bought or sold) this item recently, then it may be 
better to wait for a while before deleting it (otherwise the Stock History will 
have a gap).
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4
Transactions
Enter details of payments, 
receipts, banking, stock, 

or create invoices

There are many types of transaction in your business, for example writing 
out a cheque; paying money into the bank, buying something with petty 
cash, or producing a Sales Invoice. To make it easy to enter the different 
types of transaction, ABC has an appropriate entry routine to suit each type.

In general terms, if the amount of the transaction is more than a few pounds 
you should have a piece of paper to prove that the transaction is genuine. 
Figures on a computer screen are very neat, but the VAT Inspector and 
Accountant prefer traditional bits of paper like bank statements, cheque-
stubs, invoices, petty cash receipts. If you do not have a bit of paper, then 
create one; write the details of the transaction onto a blank sheet, and put 
that into your ring-binder. Every transaction entered into ABC is given a 
folio number; (page 21) you should write this number onto the bit of paper. 

We recommend you get into the habit of always doing this in some 
distinctive way; eg. get a rubber stamp, or use a purple pen, and always put 
the number in the bottom right hand corner of the document. This makes it 
easy to check, and if you find a document with this number on it you know 
it has already been entered into ABC.

When it comes to entering transactions into ABC, you can save time by 
collecting together similar items and entering them as a batch.
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First thing to do is decide which type of transaction you are entering. Here 
are the most common

Money Received - page 39
Invoice payments (for credit items, relating to a Sales Invoice)

Cash sales (miscellaneous non-credit items, eg till receipts) VAT Refund 
from Government

Money Paid - page 45
Pay a bill (purchase invoice)

Cash payments (petty cash) (for misc. non-credit items) Including: Wages 
to employees; NI, PAYE to government;  Proprietor drawings; VAT 
Return to Government

Internal Adjustments - page 51
Bankings (take Money on Premises to the Bank); Write a cheque for petty 

cash tin; Opening Balances for Customers or Suppliers (Sales Ledger, 
Purchase Ledger); 

Opening Balances (Nominal Ledger);

Transfers (Nominal Ledger Journal)

Stock (Inventory) - page 55
Stock Value (enter results of Stock Take); 

Goods In or Out.

Unpaid Bills (from Suppliers) (Purchase Invoices) - page 56

Sales Invoices - page 58
Create new invoice, or enter details of a handwritten invoice.

Also Credit Note, proforma Invoice, or Delivery Note.

Corrections (adjustments) - page 62
Everybody makes mistakes from time to time. When you spot something 

wrong, simply enter a correction.

The following pages describe each type of transaction, and explain how to 
enter it into ABC.
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Money Received
Decide if this is  

A. a payment for a Sales Invoice,  
or  B. a small miscellaneous sale (eg. via the shop till) 

A. Payment received for an invoice
Sales Ledger > Customer Records  
> Select the Customer  > Receive Money

If you do not know  the Customer name but have the 
Invoice Number the FIND function has an option to get 
the matching Customer record. 
 

The normal procedure is to first enter the amount of money received (and 
the date, payment method, etc). Then you can allocate this against one or 
more invoices, to mark the items as paid.

However, you could just enter the money.  Later you can mark items paid -- 
by allocating Credit Notes, Opening Balances, etc against invoices.  You can 
part-pay any invoice. 

Sometimes you may allow the Customer a Discount. And occasionally the 
Customer will pay the wrong amount (eg. send a cheque for £34.12 instead 
of £34.21). ABC makes it easy to handle these entries.

You can even make ABC automatically allocate any 
receipts against invoices at month end and this brought 
forward option can be set for just some customers. See 
Page. 

Enter money details
The entry screen for you to enter details of the money transaction is shown 
on the next page. 

ABC gives every transaction a computer Folio Number (eg. CB010027)  as 
you enter it, and you may want to make a note of this (eg. write it onto the 
Bank Paying-In slip).
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Details of Fields for entering money received

Field Description

Amount received The amount of money received from the 
Customer.

Method of 
Payment

In what form was the money?  page 104 

Date of this 
transaction

Today’s date is provided as the default; but you 
can change to a different date. ABC expects 
the date to be within the current bookkeeping 
month; but you can put a future month if 
necessary. You cannot use a previous month 
date.     page 103 

Paid Into Specify the Analysis Heading where this money 
will be placed. Normally it should be the 
MONEY ON PREMISES (for cash/cheques); but 
could be a BANK (if Direct Debit etc).  Page 103

Our Reference A reference number or name (eg. the initials of 
the person making this entry; or the number 
from your bank paying-in book page)

Note A description of this transaction. Can be left 
blank.
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Discount
If you tick the ALLOW DISCOUNT box, additional Fields appear to allow 
you to enter and calculate a Settlement Discount for this payment. 

The Customers account balance will be reduced by the Amount of money 
they have paid, plus the discount. 

Field  Description

Amount Received The actual amount of money received from the 
Customer.

Discount percentage ABC displays this automatically (in brackets).

Discount You can enter an amount here; or enter a 
percentage (eg 3%)

Total ABC calculates this figure automatically. This 
is the amount by which the Customer account 
balance will be reduced. You can play about 
with the above Fields to get the Total to what 
you require, and then tick the FREEZE box (to 
keep the total fixed). Now you can adjust the 
other Fields as required. 

Allocate (mark invoices paid)
Select the Allocate tab page. This shows all unallocated items for the 
Customer (Invoices, Credit Notes, Discounts, Opening Balances, Brought 
Forward amounts, and Money Received).

These all need to be Allocated where possible -- for example, to mark an 
Invoice as paid by allocating Money or Credit Note against it. This can be 
done at any time.  If you are using Cash VAT Accounting it is important to 
Allocate as many items as possible before printing a VAT Return.

In the left column you can enter:

   Y -- YES, PAID in full (Allocate this item) 
   P -- to Part-allocate (then you enter the amount to part-pay) 
   N -- NOT PAID (ie. cancel either of the above)
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It is this process that alters the Amount Outstanding 
Field in the history/statements. When the outstanding 
amount is zero; an item is considered paid. You can 
also part-pay an item. If this Customer Record has 
the Option set as Brought Forward the computer will 
automatically allocate any money against the oldest 
invoices during the next Month End.

As you Allocate each item the Allocated TOTAL will change. We 
recommend you begin by allocating any money, credit notes and discounts  
these all will decrease the Allocated Total. Now start allocating invoices and 
any Balances Forward  this will increase the Total.  Stop when the Total gets 
back to zero (ie. an exact match between money and invoices). 

If you select SAVE when the  Allocated Total is not zero, ABC will query 
this, and offer you several alternatives to get rid of the discrepancy:

STORE AS BALANCE  create a new Brought Forward item.

WRITE-OFF (as a Discount)  useful for small amounts, eg. if a Customer’s 
cheque is wrong by 2 pence.

ALLOCATE  go back and try again.

EDIT MONEY  go back to previous section and edit details of the 
payment received.

Refund to a Customer
Treat this the same as Money Received from a Customer (see above) but 
enter the amount as negative.

Contra Payments
If you owe a Supplier for an invoice, and they also owe you some money, 
you can cancel one against the other to save you both having to write out 
cheques (obviously they must also agree to this). This is known as paying 
by contra.

You should enter both the Sales and Purchase sides of this transaction 
at the same time, and the amount must be the same in both cases. (If the 
invoice on either side is of a greater value, then just mark it part paid by the 
smaller amount).

Use the special Heading 8395 for all Contra Payments.

42	 |	 ABC6 User Manual



B. Cash Sales income
ABC gives you great flexibility when entering CashBook income. You 
can enter a batch of transactions (or just one) and then post these to the 
accounts immediately. Or you could store the batch, and continue entering 
at a later time (may be useful to let someone else check the entries before 
they are made final). You can print the batch of entries on paper, before or 
after finalising them.

Cashbook > Cash Income
You can switch between the previous batch and the current batch of 
entries. When you finalise the current batch it is posted to the accounts and 
becomes the previous batch. Only the current batch can be edited.

ABC generates a CashBook Folio Number (eg CB001234) for each item that 
you enter. We recommend you write the Folio Number onto each receipt 
or bit of paper as you enter them into ABC -- this makes it easy to cross-
reference from the Audit Trail later. page 21 

The following Fields must be completed for each line.

Field  Description

Date The date must be within this bookkeeping 
month; or a future month. page 103

Analysis Heading What was this amount for? Enter an Analysis 
Heading CODE.      page 103
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Note Imagine you are looking at a list in six months 
time; and trying to remember what this entry 
was for. The note will appear on the list; try to 
type something meaningful.

Reference For your own use. For example; the Bank Paying-
In Book page number. Or your initials.

Amount Enter the total amount (including VAT).

VAT Code The VAT Code for this transaction. page 104

VAT Amount Enter the Amount of VAT.  
 
VAT Calculation: With the cursor in the 
VAT Amount field; you can press F8 and the 
computer will calculate the VAT amount for you 
(at whatever rate you specified with the VAT 
CODE).

Method In what form was this money? Cash? Cheque? 
Direct Debit?    page 104.

Bank Heading Where did you put this money? To your 
Petty Cash Tin? or to Money on Premises 
(recommended) for Banking later page 104

As you complete each line, the amounts are added to the Batch Total at the 
bottom of the screen. You can Cursor up or down to move back and correct 
any entries you have just made. 

You can save your work and resume tomorrow, or finalise the batch 
immediately. 

The Summary Tab Page shows an analysis of the Headings you have used, 
and the VAT split. You can print a Batch Report at the end. Some people 
find it useful to print this list of what they have just entered, and store it in 
a ring-binder with any associated pieces of paper (eg. till rolls).

VAT refund from the Government
Enter this as a Cash receipt, with VAT Code N (Not Applicable). The 
Analysis Heading is 9211, and the Cash/Bank Heading is wherever you put 
the money, eg 8481-Money On Premises or 8411-Bank.
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Money Paid
Decide if this is a  

A. Payment for an Unpaid Bill (Purchase Ledger Invoice), or  

B. Small cash (ie. not “credit”) purchase.(eg. wages, VAT or tax payment, 
petty cash for stamps or petrol)

A. Purchase Ledger Invoice payments
Normally it is convenient to first “tick” the unpaid bill(s) that you wish to 
pay, and ABC will show the total amount of money. ABC does allow part-
payment of invoices, and paying of several invoices at one time. You can 
instead make an arbitrary payment to a Supplier.

A Remittance Advice Note and/or Cheque can be printed.

Purchase Ledger > Supplier Records  
   > Select Supplier Record >  Money Pay

If you know the Invoice Number but can’t remember 
the Supplier Name, you can locate the Supplier from 
the invoice number. 
 
.

The Allocate Tab Page shows a list of all unallocated items for the Supplier 
(these can include Invoices, Credit Notes, Discounts, Opening Balances, 
Brought Forward amounts, and Money Paid).

These all need to be Allocated where possible -- for example, to mark an 
Invoice as paid by allocating a Money Paid against it. This can be done 
at any time.  (If you are using Cash VAT Accounting, it is important to 
Allocate as many items as possible before printing a VAT Return.

In the left column enter:

Y -- YES, PAID in full (Allocate this item)

P -- to Part-allocate (then you enter the amount to part-pay)

N -- NOT PAID (ie. cancel either of the above)
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It is this process that alters the Amount Outstanding 
Field in the history/statements. When the outstanding 
amount is zero; an item is considered paid. You can 
also part-pay an item. If this Supplier Record has 
the Option set as Brought Forward the computer will 
automatically allocate any money against the oldest 
invoices during the next Month End.

As you Allocate each item, the Allocated TOTAL will change. We 
recommend you begin by allocating any money, credit notes and discounts. 
These all will decrease the Allocated Total. Now start allocating invoices 
and any Balances Forward  this will increase the Total.  Stop when the Total 
gets back to zero (ie. an exact match between money and invoices).

If you select SAVE when the  Allocated Total is not zero, ABC will query 
this, and offer you several alternatives to get rid of the discrepancy:

STORE B/F --  create a new Brought Forward item.

WRITE-OFF -- (as a Discount)  useful for small amounts, eg. if you paid 
three pence too much by mistake, this allows you to get rid of it

ALLOCATE -- go back and try again.

EDIT -- go back and change the money amount.

Arbitrary payment
If you wish to make an arbitrary payment to a Supplier, just enter this on 
the Money Details tab page and then SAVE.  You can Allocate it at another 
time.

Print Remittance Advice or Cheque
You can print either of these at this stage. You cannot come back later and 
print them. 

If the printout does not match your stationery, it can be 
customised to suit. 
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Details of the payment

The following fields must be completed:

Field  Description

Amount Paid The amount of money paid to the supplier.

Method of Payment In what form was the money? page 104

Date of this transaction We suggest the date is within the current 
bookkeeping month.  page 103

Paid from Heading Specify the Analysis Heading from where 
this money will be paid. It must be one of 
your Bank Headings. page 103

Our Reference This might be your cheque number

Note A brief comment about this transaction. Can 
be left blank.

Discount
If you tick the ALLOW DISCOUNT box, additional Fields appear to allow 
you to enter and calculate a Settlement Discount for this payment. 

The Suppliers account balance will be reduced by the Amount of money 
you are paying, plus the discount. 
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Field  Description

Amount Paid The actual amount of money that you pay to 
the Supplier.

Discount percentage ABC displays this automatically.

Discount You can enter an amount here; or enter a 
percentage (eg 3%)

Total ABC calculates this figure automatically. This 
is the amount by which the Supplier account 
balance will be reduced. You can choose to 
fix this total (play about with the above two 
Fields to get the total to what you require and 
then tick the FREEZE box) and then adjust the 
Amount Paid and Discount.

Refund from a Supplier
If you need to enter a Refund from a Supplier, enter it as a payment but as a 
negative amount, eg. -18.73

You cancel (stop) a cheque to a Supplier
Enter it as an arbitrary payment as described above but enter the amount of 
the cheque as negative, eg. -35.12

Contra payments
If you owe money to a Supplier, and they also owe you some money, you 
can avoid both having to raise cheques by simply cancelling your invoice 
against theirs (obviously they must also agree to this). This is known as 
paying by contra. 

You should enter both the Sales and Purchase sides of this transaction 
at the same time, and the amount must be the same in both cases. (If the 
invoice on either side is of a greater value, then just mark it part paid by the 
smaller amount).

Use the special Heading 8395 for all Contra Payments.
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B. Cash Payments (ie. not “credit”)
These are small miscellaneous purchases (by cash, credit card, cheques, 
etc) for example buying petrol, stamps, stationery at the local shop, paying 
the window cleaner.   You would also use this CashBook for entering details 
of paying your VAT Return, proprietor drawings, cashing a cheque to put 
money in the Petty Cash Tin, and paying Wages to employees (and Tax/NI to 
the Inland Revenue).

You can enter a batch of transactions (or just one) and then post these to the 
accounts immediately. Or you could store the batch, and continue entering 
at a later time (may be useful to let someone else check the entries before 
they are made final). You can print the batch of entries on paper, before or 
after finalising them; and you can recall the previous batch of entries to 
view or print.

Cashbook > Cash Payments
You can switch between the previous batch and the current batch of entries. 
When you finalise the current batch it is posted the accounts and becomes 
the previous batch.  Only the current batch can be edited.

ABC generates a CashBook Folio Number (eg CB001234) for each item that 
you enter. We recommend you write the Folio Number onto each receipt 
or bit of paper as you enter them into ABC -- this makes it easy to cross-
reference from the Audit Trail later. 

The following Fields must be completed for each line.

Field  Description

Date The date must be within this bookkeeping 
month or a future month. page 104

Analysis Heading What was this amount for? Enter an Analysis 
Heading CODE.  page 103

Note Imagine you are looking at a list in six months 
time and trying to remember what this entry 
was for. The note will appear on the list; try to 
type something useful (example... Employee 
name, description of item, reference number, 
etc).

Reference For your own use. Some useful reference. For 
example; the Cheque number. Or your initials.

Amount Enter the total amount (including VAT).

VAT Code The VAT Code for this transaction.    page 104 
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VAT Amount Enter the Amount of VAT. 
 
VAT Calculation: With the cursor in the 
VAT Amount field; you can press F8 and the 
computer will calculate the VAT amount for you 
as specified by the VAT CODE.

Bank Heading Where did the  money come from? Petty Cash 
Tin? Cheque from Bank? Credit card? page 103

As you complete each line, the amounts are added to the Batch Total at the 
bottom of the screen. You can edit any entries you have just made. 

You can save your work and resume tomorrow, or finalise the batch 
immediately. 

The Summary Tab Page shows an analysis of the Headings you have used, 
and the VAT split. You can print a Batch Report at the end. Many people 
find it useful to print this list of what they have just entered, and store it in 
a ring-binder with the bits of paper (receipts) to form your Petty Cash Book.

Wages payments to staff; VAT or tax to Inland Revenue
Payments that you make to staff (paying wages), and payments to the 
government (paying tax and NI, and VAT Returns) should be entered as 
CashBook > Cash Payments. These are all VAT Code “N”.

Direct Debits/Bank Charges
Enter these and tick them off on your bank statement (to ensure you don’t 
enter them twice). Use CashBook > Cash Payments for these items.

Accountants only seem to believe bank statements, so most prefer you 
to enter these items only after you see them in black and white on the 
statement. This may cause you to be a month behind in entering these 
items.  Check with your accountant -- we think they will still prefer this.

Standing Orders
You can store a list of regular transactions. Typically each month you call 
up the list and tick those items you wish to process (post to the accounts). 
ABC will stop you accidentally posting the same item twice in a month. 

CashBook > Standing Orders
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Internal adjustments/movements
These transactions take place within your business, ie. they are internal. 
For example, getting money from your bank to put in your petty cash tin, or 
making a correction for analysing an expense against the wrong Heading. In 
all these cases the VAT Code is N (Not Applicable).

Transfers (Nominal Journal entries) should be the last resort  -- use only if 
you cannot find a better way of entering a transaction.

Bankings
Most of the money you receive (entered using Money Received in Sales 
Ledger) is normally posted to the MONEY ON PREMISES Heading.  It 
remains there until you use BANKINGS to transfer it to the bank. You 
should use the figures from your bank paying-in book to enter BANKINGS; 
and put the bank paying-in book reference as the Note.

When you select BANKINGS, the screen will contain the following items on 
each line. Generally you only enter a single figure for each type of money 
(eg. total of cheques, total of cash). 

The reason for this procedure is to make the computer Bank Report agree 
exactly with your real bank statement, for easy reconciliation.

Cashbook > Banking
Start by selecting which Bank Account you have taken money to. Then 
enter one or more banking transactions. For each line you need to fill in the 
following columns:

Field  Description

Date Must be in current Bookkeeping Month. page 103

Note Any note or comment

Amount The total amount of this batch of items; ie. the 
amount shown on your bank paying-in slip.

BankBook The reference number from the page of your bank 
paying-in book. 

Method Type of items in this batch. eg Cheques?  page 104

ABC generates a Journal Folio Number (eg JN001234) for each line. You 
should write this on the Bank Paying-in book counterfoil, or on the bank 
statement -- it helps cross-reference from the Audit trail.
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Bank Reconciliation
This allows you to compare your real bank statement with the ABC List of 
bank transaction. Ideally they would agree exactly, but sometimes you will 
find differences -- eg. a direct debit or standing order you have not entered 
into ABC, or a cheque that didn’t get paid into the bank. These differences 
need to be “reconciled”.

CashBook > Reconcile Bank
Typically you should tick off on the bank statement and computer screen 
each item that appears on both. And then investigate any item on either list 
that is not ticked.

Start by selecting a bank account. When you have finished, it may be useful 
to print a list of unreconciled items on paper.

Writing a cheque for the petty cash tin
If you get money for the Petty Cash Tin by cashing a cheque at the bank, 
enter it here:

 Cashbook > Enter Payment

Opening Balance to Customer/Supplier
This function is normally used only when you set up a new Customer 
Record. Note that the Opening Balance is simply a total amount of money 
-- any VAT must be handled separately (page 19) For Suppliers, use the 
Purchase Ledger instead.

Sales ledger > Customer Records  
    > Select customer > Opening Balance

Opening Balances (Nominal Ledger)
You can edit the Nominal Ledger Opening Balances for the current 
accounting year.

Nominal Ledger > Direct Entries > Opening Balances
After editing the Opening Balances, ABC allows the option to write these 
figures into the Headings (N/L Accounts) Records.

The Opening Balance Edit screen shows for each account (Heading) 
whether it is a Credit or a Debit account, but you do not need to think 
about this when setting the opening balance figure; just set each account 
(Heading) to the opening balance figure it should be, for example set Bank 
Account 8411 to eg. £3456.12 (unless it is overdrawn in which case you 
would put a negative figure  eg  -£456.78)

You cannot exit from the Opening Balances Edit until the books are 
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balanced, ie. total Db = Total Cr.

When you run the Year End function (page 73) the Closing Balances for this 
year can be used as the Opening Balances for next year.

These opening balances are stored in a separate file and you can edit them 
without affecting your accounts. ABC will not let you exit until they are 
balanced (ie. Total Db = Total Cr). You can choose to write these figures to 
the accounts (to the Opening Balance fields of the N/L accounts.  The N/L 
current Balances are made up of the Opening Balance (at start of year) plus 
transactions for this year to date.

Transfers (Nominal Journal)
Most Bookkeeping entries will be made through the Sales/Purchase 
Ledgers or CashBook. The Nominal Ledger Journal should only be used for 
those few adjustments or corrections that need to be made directly to the 
Headings (N/L Accounts). We suggest you do not use Transfers unless you 
cannot find any other way.

Examples of Transfers
Make adjustment required by Special VAT Scheme 
Transfer money from current account to deposit account 
Adjust Prepayments, Accruals, Depreciation 
Correction of mistakes.

Nominal Ledger > Direct Entries > Journal (Transfers)
Each line is one complete balanced entry; the transfer of an amount from 
one Heading (N/L account) to another. You need to fill in the following 
columns.

Field  Description

Date  Must be in current Bookkeeping Month.    page 103

1st Heading  The Heading you are adjusting.                  page 103

Adjustment  The amount of this adjustment. You can put a 
positive or a negative amount. A positive amount 
will increase the Heading’s balance. Do not worry 
about “Debit” or “Credit” -- ABC takes care of all 
that.

Note  Any comment or description of this entry.

2nd Heading  The balancing Heading. You are Transferring an 
amount from one Heading to another -- this is 
the other. ABC takes care of Debit and Credit and 
ensures everything stays balanced. page 103
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The Summary Tab Page shows the effect of this batch of entries.

VAT normally is not involved in Transfers, because all you are doing is 
making internal adjustments within your business. 

The expressions Increase or Decrease the Analysis 
Heading are translated by the computer to 
automatically Debit a Debit Heading (for increase) or 
Credit a Credit Heading (increase). Entering a negative 
amount to Adjust a Heading will Credit a Debit 
Heading, or Debit a Credit Heading. 

Wages Summary
The calculations for wages must be done as a completely separate task, 
either using the Inland Revenue Tax Tables and cards (or CD calculator), or 
on a computer Payroll System (eg. the ABC Payroll). The summary can then 
be posted to ABC Accounts here:

 Nominal Ledger > Direct Entries  > Wages Summary
This posts the total liability to the Balance Sheet (Heading 9221) after you 
enter details of the wages, tax and NI totals.The totals are what you owe (to 
the government and to employees.

When you come to actually pay these people (eg. write the cheques), use 
the normal CashBook > Cash Payments for the individual payments (the 
Analysis Heading for those should be 9221). (page 103)

An easier solution is to get our Payroll Module. Not 
only does it do the calculations and produce all the 
paperwork, but it can automatically make the postings 
to the ABC Accounts system 

Stock Value
ABC will display the computer’s value of your stock and you can enter a 
New Value. Usually this should be based on a Stock Valuation report. This 
figure can affect your Profit & Loss and Balance Sheet (and your accountant 
may adjust the value for various reasons).

Nominal Ledger > Direct Entries > Stock Value
This entry will write the new Stock Value to Heading 8121 (Current Assets) 
and the stock movement to Heading 3981 (Cost of Sales).
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Stock (Inventory) transactions

Enter Goods In
Stock items received from suppliers.

Select Stock Record > Stock In

Enter Goods Out
Items you are taking out of stock for some reason (if you use Stock Codes 
on Sales Invoices, those items are automatically taken out of stock by the 
invoicing system).

Select Stock Record > Stock Out

Enter Stock Adjustments
After completing a Stock Take, you might find the actual number of some 
items in stock is different to the computer figure. Use this function to 
correct the computer by entering adjustments. 

Select Stock Record > click on ADJUST tab Page
This function might also be used to enter Stock Opening Balances.
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Unpaid bills (purchase invoices)
Select the Supplier Record  >  Unpaid Bill

If you do not already have a Supplier Record for this Supplier, you can Add 
one at the same time (page 26)

Enter the following details from the Supplier invoice: 

Field  Description

Invoice Number.  The invoice number from the unpaid bill.

Date on the Unpaid Bill  The date as shown on the unpaid bill. It 
does not matter if this date is not in your 
current bookkeeping month; but ABC will 
store the transaction in this months books.

Our Description  A few words to describe this purchase. 

Invoice Total  The total amount as shown on the unpaid 
bill. (including any VAT).

Amount of VAT  If this unpaid bill includes any VAT; you 
must enter the exact figure that is shown 
on the bill (even if the Supplier got their 
calculations wrong; you must still enter 
their figures).

Their Account number  If the unpaid bill shows an Account 
number that the Supplier uses for our 
company; then you can enter this here (it 
will then be shown on any Statement or 
Remittance advice).

Now analyse the invoice total against one or more Headings, on the 
Analysis Tab Page. The following columns must be completed:

Field  Description

Analysis 
Heading Code

Normally will be a Cost of Sales (3000 ) 
or Expense Heading (4000)                   page 103

Description A few words to describe this line.

VAT Code Amount excluding VAT The amount (excluding 
VAT) for this line Shortcut: If you leave the 
Amount blank ABC will fill in the remaining 
amount.

Often you may just analyse the item against one Heading, but up to 99 
Headings could be used.
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Before you can finish, the Goods Total shown at the bottom of the window 
must agree with the figures you entered on the Invoice Summary tab page. 

ABC generates a Folio number for the Unpaid Bill; you should write this 
number on the invoice. It is a good idea to use a special colour pen for this 
to allow you to see immediately if an invoice has already been entered.

Debit Notes
(a Credit Note received from a Supplier) Treat exactly as an unpaid bill, but 
enter the Amounts as negative.

VAT-only Invoice
Sometimes you may have to enter an Unpaid Bill that contains only VAT. In 
this case the Invoice Total will be the same figure as the VAT amount. You 
still need to analyse this against a purchase Heading, but it doesn’t really 
matter which one since the goods amount is zero. Put VAT Code 1.

To indicate to ABC that this is a special VAT-Only Invoice, tick the box on 
the ribbonbar.

Update Stock
You can update your stock quantities while entering the unpaid bill. Tick 
the box on the ribbonbar to cause the additional stock columns to appear. 
(or untick the box if you do not wish to use this facility.
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Sales Invoices
ABC includes a full invoicing module (linked to the Stock System).

Invoices can have your choice of logo (small picture) printed at the top, and 
if you want to print a Message (eg. Special Offers this week) at the bottom 
of the invoice, a choice of attention grabbing borders can be used.

You can produce one or more proforma invoices for a Customer, and these 
can later be edited, printed, turned into a real invoice or deleted.  Delivery 
Notes can be printed (from the Options tab of the Invoice).

Once an invoice has been “Finalised”, it is written to the accounts files and 
cannot be changed any more -- but you can reprint it at any time (page 29).

Sales Ledger > Customer Records > select Customer > Invoice

If you currently have some part-finished or proforma Invoices for this 
Customer you can select one of those, or create a new invoice

The Invoice Top contains these Fields

Field  Description

Account number  
Invoice number

The computer fills these items into the 
invoice and you cannot alter them here.

Invoice Date This is the tax point for VAT. It must be 
in the current (or a future) bookkeeping 
month.

Supply Date Useful as a note, for example the date 
when the goods were supplied. Can be left 
blank. 

Your Ref. Any note (eg. the Order Number or a 
name). Can be left blank. This will be 
printed on the Daybook. If you entered 
anything in the NOTE Field on this 
customer Record; it will appear here by 
default.

Our Ref Any note or reference (eg. Delivery Note 
nbr.) or can be left blank. This will be 
printed on Daybook.

Trans. Type Any note describing this transaction. Can 
be blank. 

Sold By Initials of salesperson; or any note. Can be 
blank.
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Delivery Ref. Any note, for example the method of 
delivery, or our Delivery Note Number. 
Can be left blank.

Delivery Address Defaults to as invoice address. You can 
enter any different address here, or leave 
it blank. Or click the button to select or 
edit a stored Delivery Addresses for this 
Customer.

Special Instructions Can be left blank, or you can enter any 
notes or instructions as required. If you do 
enter a message here, you can enhance it 
by printing an attention grabbing border 
-- see the Message Border tab.

Notes Any further notes or instructions.

Special Invoice types
You can modify the behaviour of an invoice in several ways, for example:

Cash-with-Order Invoice (if the invoice is being paid immediately). This 
is just a short-cut to save you having to separately go and mark the 
invoice paid later.

VAT-inclusive Prices. Instead of entering net price, and letting ABC add 
on the VAT, the VAT-Inclusive Invoice takes the prices you enter as 
already containing VAT; ABC will then automatically separate the 
VAT and show it on the invoice.

VAT-only Invoice. Not a common requirement for most businesses, but 
some companies need these (eg.import/export agent). This is an 
invoice with zero value of goods, but an amount of VAT. 

Invoice at Zero VAT rate. For certain categories of customers only.

1. The VAT-only option will override any other special 
invoice selections. 
 
2. Only the first line can be used, and the Amount is 
taken to be the VAT (and put against VAT rate 1)

To specify one of these special types, see the OPTIONS tab page.
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Delivery Address
ABC allows you to store multiple delivery addresses for any customer. Click 
the Delivery Address button on the Invoice Top/Bottom to view/edit/add 
addresses. 

Customer Reference
Several Fields from the Customer Record will be filled into the Invoice Top. 
You can also use the last stored Invoice Top for this Customer as the basis of 
the new Invoice -- see Options tab page.

Body of the Invoice
The body of the invoice can contain up to 99 lines.

Some lines may contain just descriptive text, and you can leave blank lines 
between items if you wish (to make invoice prettier).

To make the invoice lines deeper, drag the line down 
at the left hand edge of the Invoice. This lets you have 
long item descriptions. 
 

Use the mouse or cursor keys to move to the line you wish to change then, 
to edit the line, double click, or press ENTER, or click EDIT.

Each line contains the following Fields.

Field  Description

Quantity The number of these items you have sold.

Stock Ref. A Stock Code. Enter ? to select from Stock File. 
Leave blank if you don’t want an item from Stock.

Description Enter a description of this item. If you have used a 
Stock Code; ABC can fill in the Stock Description 
here.

Unit Price Enter the unit price of this item (excluding VAT 
unless you are working with VAT-inclusive prices).

Discount You can enter a trade discount that applies to this 
line only. Either enter a figure; or a percentage (eg 
3%). This discount can be positive or negative (ie. a 
surcharge).
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Amount The net amount for this line (ie. excluding VAT 
unless you are working with VAT-inclusive prices). 
ABC can calculate this from the Quantity, Unit Price 
and Discount.

VAT Code Enter the CODE to specify which rate of VAT applies 
to this entry line.  page 104

Heading code Enter an Analysis Heading Code.  page 103

ABC will check each line and alert you to any problems. You cannot Finish 
the line until you correct any errors.

While entering the lines you can right-click the mouse for editing functions 
including Copy, Insert, Cut, Clear, or Paste lines.  

When you have finished editing the invoice you have the options to print 
a ProForma Invoice, Hold the Invoice (store on disk as a part-finished 
Invoice), or Finalise the Invoice). The invoice can be edited or deleted at 
any time until you Finalise it -- thereafter it cannot be changed. (It only gets 
posted to the accounts when it is finalised).

Print the Invoice
A Part-finished Invoice can be printed as a Proforma Invoice. The proper 
invoice can only be printed after it has been finalised. It is possible to 
reprint old invoices at any time (page 29).

If you are entering details of hand-written invoices you may choose not to 
print anything.

Delivery Advice Note/Estimate/Quotation
You can print any of these items by selecting from the Options tab page. 
These are copies of the invoice but you can choose the words printed at the 
top, and whether or not to show prices.

Credit Notes
Create an invoice as normal but arrange that the final total is negative. This 
can be done either:

a) by entering a negative price and no stock code. This will not affect the 
Stock File

b) by entering a stock code and putting the quantity negative. This will 
put the items back into the Stock File (eg. if the Credit Note is for 
goods returned to you).
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When this negative invoice is printed, the words CREDIT NOTE will appear 
instead of INVOICE.

Settlement Discount
If you have ticked the Settlement Discount box (Customer Record -- Options 
tab page) then your standard settlement discount terms will be printed on 
the invoice. For example, 2% discount for payment within 7 days. 

Link to the Stock File
You can call a description and price from the Stock File. This saves you 
typing the information, and of course ensures the price is right. You will 
find this useful even if you don’t need Stock Control at all, as you can store 
lines of text that you often use on invoices -- see Page .

Enter a Stock Code on the Invoice (or select from the drop down list) and 
ABC will fill in the description, price, VAT Code and Analysis Heading 
from the Stock Record.

If you have entered a Quantity, then it will be deducted from the Quantity 
in Stock Field on the Stock Record Card.

Picture (company logo) on Invoice
To make your invoices look more professional and businesslike, you can 
print your company logo (or any small picture) at the top. Select the picture 
or turn off this function on the Options tab page.

Message with border
You can print an attention-grabbing border around your message at the foot 
of the invoice. The Message Border tab has several choices, including No 
Border. If you do not enter any text in the Special Instructions box on the 
Invoice Top/Bottom, then no border will be printed anyway.

Corrections and Adjustments
In general, you should always make any corrections or adjustments by 
creating a new transaction, complete with a piece of paper. From experience 
we have found this is the best way to keep Accountants and Tax Inspectors 
happy, and to make it clear what you have done.

For example, if you invoice the wrong company or for the wrong amount 
you can correct the situation most neatly by creating a Credit Note to cancel 
the incorrect invoice. In the Reference Field of the Credit Note put the 
Invoice Number of the original invoice.
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5
Printing reports
Viewing lists, labels, summaries  
on screen, paper, or to disk file

When you select any Report in ABC, it is first displayed on screen in 
the Preview Window (page 112).  This allows you to check the contents; 
zooming in or out, and moving from page to page. Select PRINT if you need 
to send the report to paper, and you can select a printer and maybe a range 
of pages. 

It is also possible to export Reports to a disk file, for example in PDF, CSV or 
HTML format for use in other applications, websites or email. 
Select File > Export > PDF, CSV, etc,  from the Preview Window.

Reports can be viewed or printed at any time, and as often as you wish. 
Plain paper is used for all printouts.

Many reports can be customised by setting options (page 112) to choose 
a range of dates, sorted order, and other criteria. ABC can be set to 
automatically print your choice of reports each Month and Year End.

In addition to the built-in bookkeeping reports, you can design your own 
reports and labels to print information from the Accounts files or your own 
files.

This chapter lists all the built-in bookkeeping reports, with a few notes 
pointing out any unusual features or options

Printing reports     |       63



Sales (Customer) reports
You can select the following reports from the Sales Ledger Menu.

List Customers A list of Customers showing their company name  
address  telephone number etc 

Customer 
Statements

Normally you print Statements to send Customers 
a reminder of unpaid items; but it may be useful 
to also show items they have paid recently. ABC 
gives you a range of options so you can choose 
what to show on the Statement; and who to send 
Statements to. Typically you would produce 
Statements at the end of each month. Also note: 
While looking at a Customer Record Card you could 
produce a quick Statement for them from the View/
Print Menu.

Customer 
History

Lists all transactions and you can choose a range 
of dates and whether to expand invoices to show 
full details or just show invoice totals. Also note: 
While looking at a Customer Record Card you could 
produce a quick History for them from the View/
Print Menu.

Aged Debtors List of everything currently owing to you divided 
into several age ranges. Telephone numbers are 
printed making this a convenient list for chasing 
overdue debts. Also shows “future” items (not yet 
due).

Money 
Received

A list of all money received in payment of sales 
invoices. (Reminder that CashBook income -- eg 
sundry cash sales-- are not included in this report 
but can be found in CashBook Receipts page 70).

Sales Daybook List all invoices and credit notes.  You can specify 
a range of dates. This is one of the basic reports 
required by your accountant and VAT Inspector.

Sales Audit 
Trail

Like an expanded version of the Sales Daybook but 
the Audit Trail also shows every line from each 
sales invoice (you can select the range of dates). It is 
mainly useful for tracking errors or auditing.

Unpaid 
Invoices

A list of invoices not yet marked as paid (as of 
today’s date). To mark an invoice as paid you 
Allocate money (or Credit Notes) against the 
invoice. (page 41)
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Re-print (or view) old Sales Invoice (Zoom)
At the Customer’s Record Card go to the Balance Tab page and see a list of 
their old invoices (use Outstanding or History option). Right click on the 
old invoice and select ZOOM (or reprint)

Letter, Label, or Envelope for one Customer
At the Customer’s Record Card choose the item you require from the View/
Print Menu. ABC can then automatically fill-in their address on the label, 
envelope or letter. You can edit these items and customise them with your 
own logo or picture

Letter or Label for all Customers
Use TYPING > MAIL-MERGE (page 91) to print letters. 
Use FILING > LABELS (page 85) to print sheets of labels.

Purchase (Supplier) Reports
You can select the following reports from the Purchase Ledger Menu.

List of 
Suppliers

A list of your Supplier’s company name address 
telephone number etc. 

Supplier 
Statements

List all outstanding items for each Supplier. Also 
note: While looking at a Supplier Record Card you 
could produce a quick Statement from the View/Print 
Menu.

Supplier 
History

The Supplier History Report lists all transactions and 
you can choose several options. Also note: While 
looking at a Supplier Record Card you could produce 
a quick History from the View/Print Menu.

Aged 
Creditors

List of everything you currently owe divided into 
several age ranges. Future items (not yet due for 
payment) are also shown.

Money Paid A list of all money paid against Purchase Invoices 
(Unpaid Bills). You can specify a range of dates.  (This 
report does not include any petty cash payments 
made through the CashBook. These are shown in 
CashBook Payments report (page )

Purchase 
Daybook

A list of all Unpaid Bills (Purchase Invoices) and 
Debit Notes entered during the range of dates you 
specify. This is one of the basic reports required by 
your accountant and VAT Inspector.
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Purchase 
Audit Trail

Like an expanded version of the Daybook, but the 
Audit Trail also shows every line from each Purchase 
Invoice -- you can specify a range of dates. Mainly 
useful for tracking errors or auditing.

Unpaid 
Invoices

List of items not yet marked as paid (as of today’s 
date). 

Zoom (view or print) an old Unpaid Bill
At the Supplier’s Record Card right-click on an old invoice and select 
ZOOM (to view or reprint)

Letter, Label, or Envelope for one Supplier
At the Supplier’s Record Card choose the item you require from the View/
Print Menu. ABC can then automatically fill-in their address on the label, 
envelope or letter. You can edit these items and customise them with your 
own logo or picture. 

Letter or Label for all Suppliers
Use TYPING (MAIL-MERGE) (page 91) 
Use FILING (LABELS) (page 85)
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Stock Reports
You can select the following reports from the Stock System Menu.

You can use the stock File to store bits of useful text 
which can be called up when invoicing to save you 
time and typing effort. These text-only Stock Records 
will not appear in the following reports. (page 33)

Stock List List of all your stock items showing their 
location quantity in stock on order and 
allocated and price.

Stock Valuation List all stock items showing the quantity in 
stock and the cost price. These figures are 
multiplied together to get the value of that 
stock item and at the end of the report the 
total value is shown. It is a good idea to print 
this report at the end of each month and then 
enter the stock value into the Accounts.

Blank Stock List List of all stock items showing the quantity 
that the computer thinks you have in stock 
with a blank space for you to enter the 
actual figure.  Print this list whenever you 
need to check your stock figures (stock-
taking or inventory). By using this list you 
will ensure that you do not overlook any 
stock items. When you have completed the 
stock-take, compare the computer stock 
quantities with the actual figure and enter 
any ADJUSTMENTS into the computer. 

Stock Sales Shows how many of each Stock item have 
been sold this month this year and the 
average per month. This is a useful guide to 
help estimate what minimum stock levels 
and re-order quantities should be, and see 
which items are selling well.

Price List List of all Stock item descriptions and selling 
prices. Prices are shown with and without 
VAT, and the price list can be printed for 
Price Group 1, 2, or 3.

Printing reports     |       67



Stock Audit Trail Full Audit Trail of all stock movements in or 
out for the range of dates you specify.

Needing Re-Order Shows items where the Quantity in Stock 
is below the Minimum Stock. Re-order 
Quantity is calculated using:  
Reorder Qty = Reorder Qty  
                    + Allocated Qty – Qty on Order. 

Nominal Ledger reports
You can select the following reports from the Nominal Ledger Menu.

List of 
Headings

Also called the Chart of Accounts. A list of all 
your Analysis Headings showing the Analysis 
Code and the type of each Heading (ie Debit or 
Credit). It also shows the overall structure of 
the way you are analysing your business. Your 
accountant will find it useful to keep this handy 
when checking other Bookkeeping reports.

Trading (P&L) Also called the Profit & Loss Report. This shows 
all Sales Purchases and Expenses during this 
period and then a calculation of your Gross Profit 
and Net Profit. Can give you an overall picture 
of the business and an idea as to which parts are 
making money and where you are spending most 
money. You can alter the layout of this report by 
changing the sub-title and sub-total Headings.

Trial Balance Lists all Nominal Accounts. The total of debit 
accounts should be the same as the credit account 
total if your books are in balance.

Balance Sheet This produces a working Balance Sheet. If you are 
an expert at accounting and have entered pre-
payments, accruals, depreciation, etc into ABC 
then this report could form the basis of the Final 
Balance Sheet for a small business. 

Audit Trail 
(Heading 
History)

List of all transactions in the order in which they 
were entered into the system. This is mainly 
useful for error checking.

Bank 
Reconciliation

Can be printed from the Bank Reconciliation 
function (page 52).

68	 |	 ABC6 User Manual



VAT 100 Report (VAT Return)
You can print a VAT Return for any range of previous months, and choose 
normal or cash VAT Accounting. You should print this report after doing 
the Month End for the last month in your VAT quarter.

Nominal Ledger > VAT Reporting System > VAT Return
The options Tab Page allows you to 
specify the range of months, and also 
to choose whether to include a VAT 
Audit and lists of unpaid Sales and 
Purchase invoices (the VAT on these is 
not included in the Cash VAT Accounting 
system so it is a good idea to check for 
mistakes).

You must check that these figures appear 
correct (you should have a rough idea of 
the total sales, total purchases, etc month 
by month) and then fill in these figures 
on the VAT Return form. Keep the printed 
report in your ring binder.

You must sign the VAT100 Return form to say that these figures are correct, 
and it is no defence to blame the computer if they are drastically wrong. If 
in doubt, consult your accountant.

If the end of a VAT period does not coincide with the 
end of your accounting year we recommend you ask 
your local VAT office to adjust your VAT period so it 
does match your bookkeeping periods. Check with 
your accountant of course, but it makes life easier for 
everyone and avoids extra calculations at year end.

VAT Audit
This report lists all transactions involving VAT. 

Nominal Ledger > VAT Reporting System > Full VAT Audit Trail

Special VAT Schemes
Some VAT Schemes require an adjustment to your accounts at the end of 
the VAT quarter. You must enter this adjustment (using Nominal Ledger 
Transfers), and ensure that you only enter it once.
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CashBook Reports
You can select the following reports from the CashBook Menu.

List of Receipts You can specify a range of dates and this report 
will list all CashBook Receipts (eg. sundry sales) 
entered during this period.

List of Payments This could form your Petty Cash DayBook. 
Specify a range of dates and this report will list all 
CashBook Payments made during this time.

List of Bankings A list of all Bankings entered during the range of 
dates you specify. Each bank account is shown 
separately.  This report should contain the same 
items as the bank Statement you receive from your 
bank -- making it easy to compare the two looking 
for errors and omissions.

Bank Statement Similar to your real bank statement this report 
shows a list of all Receipts and Payments to a 
bank.

Design your own

Print a Report or sheets of Labels
You can use FILING to design your own reports or labels to print data from 
the Accounts files. This is a safe function to use, and can not affect your 
accounts data. page 86.

Print a single label, envelope, letter or statement
While looking at a Customer (or Supplier) Record Card you can quickly 
print an envelope, letter, label or statement from the View/Print buttons on 
the ribbonbar.
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